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INTRODUCTION

This manual contains information for HD Connect the Desktop App for the Forney HD Flame Detector
from Forney Corporation, 16479 North Dallas Parkway, Suite 600 Addison, TX 75001.

All personnel should become thoroughly familiar with the contents of this manual prior to using this
product. Because it is virtually impossible to cover every situation that might occur during operation
and maintenance of the equipment described in this publication, personnel are expected to use good
engineering judgment when confronted with situations that are not specifically mentioned herein.

PROPRIETARY NOTICE

The contents of this publication are proprietary data of Forney Corporation. Reproduction or use of any
part of the publication for purposes other than the support of the equipment for which it is published is
permissible only if expressly authorized in writing by Forney.

SAFETY AWARENESS

Safety is YOUR responsibility and must always be primary concern. The guidelines covered in this
manual will greatly improve your ability to safely install and maintain this equipment. It is the equipment
owner’s responsibility to ensure that the concerned personnel fully understand and abide by all site-
specific Health, Safety, and Quality protocols. Safety summaries and procedures can never replace good

common sense!

PERSONAL PROTECTIVE EQUIPMENT (PPE)

All involved personnel should follow their site-specific Health, Safety, and Quality guidelines.

SAFETY ALERT SYMBOLS

ALL labels in this manual should be carefully observed, read, and understood. Standard labels are as

follows:

A

Indicates a hazardous situation which, if not avoided, will result in
DANGER death or serious injury.

death or serious injury.

CAUTION Indicates a hazardous §ituation which, if'ngt avoided, could result in
Z r 5 minor or moderate injury.

Indicates a hazardous situation which, if not avoided, could result in
& WARNING

NOTICE Indicates unsafe practices that can result in property damage only.
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REVISIONS

REVISIONS DATE COMMENTS
A 07/17/2018 Initial Release
B 02/15/2019 Update Monitor and Tune Screen shots, add note on page 4
© 03/20/2020 Added Bluetooth® Section
D 12/21/2020 General Rewrite
= 11/15/2023 Revised Vibration Specifications

NOTICE: If any of the procedures or instructions provided in this manual are unclear, contact
Forney for clarification. Forney Corporation offers complete, on-site service solutions to ensure
proper installation, programming, commissioning, and troubleshooting.
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HD Connect software is a user-friendly tool used to monitor performance and tune the HD Flame Detector

using a Windows® computer. The software connects to the HD Flame Detector via RS-485 connection
(Communication port).

HD Connect can be installed on a Windows® computer running Windows 8 or later. Please follow
installation instructions provided separately to install the software.

Note:

1. HD Connect and HD Mobiles App cannot be simultaneously connected to the same HD-01 Flame

Detector.

At any given time, an HD Detector can communicate with only one external device (either through HD
Connect or the HD Mobiles App).

2. When using HD Connect, if an HD Flame Detector does not appear in the list of connected devices,
check and verify if the target device is already connected to a mobile device using Forney App over the
Bluetooth® connection. If the target HD Detector is connected via Bluetooth, first disconnect Bluetooth
connection, then hit refresh button in HD Connect to discover the target device.

3. A maximum of 32 HD-01 Flame Detectors can be connected on a single USB/COM port using the
RS-485 connector. If more than 32 HD-01 Flame Detectors need to be connected to the same computer,
the user must either use a USB hub or connect them on multiple USB ports on the computer. All HD-
01 Flame scanners are shipped with default MODBUS Slave ID as #1. When more than one HD-01 is
being installed in the same network connect each HD-01 and refer Sec 4.3.2 to change the Slave ID. In
the same network each HD-01 must have different Slave IDs. Alternatively Forney Mobile App can be
used to change the Slave IDs if permitted.

4.1f HD Connect or any DCS controller is continuously pulling data from an HD Detector, it must be
disconnected (by unchecking the corresponding box in HD Connect Software -- see Section 1.3) on
COM port of HD Connect or other prescribed procedure for DCS controller prior to connecting it via
Bluetooth. Furthermore, the Forney App should be launched on the mobile device after disconnecting
the HD from COM port.
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.Io.l LOGIN SCREEN

HD Connect launches with a Login screen as shown in the Figure 1. HD Connect has two possible user
types: admin and standard. The admin users can add, delete and modify permissions for new or existing
users, while standard users have restricted access.

Figure 1 Login Screen

HD CONNECT

(FORNEY

a |U ser Name
ﬂ Password

Several features in HD Connect allow users to save data in log files, change register values, view live
data or change HD parameters. The permission to perform these functions are set by admin users for
standard users.

1 02 USER SECURITY CONFIGURATIONS

Admin users have permission to all functions of HD Connect. Figure 2 and Table 1 below list the functions
controlled by Admin users for standard users. The Admin can enable or disable features for the Standard
User to grant them permissions selectively.
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Figure 2 Security Configuration Pop-up

def

Miscellaneous Permissions

Figure 3 Standard User Security Options

I B secusiny Corfiguiation

Fomey

- b4

S T LI
S Tuning
o ierm
Admin has all the Permissions ok
S} B el
mELNT L]
L E L]
L

Tacs

Live Trend

=

raiskoggTg

Faiih Sratus

1040}

Misce lanegis Femmistians

Table 1 Permissions for Standard Users

Spectrum® Allows users to view the Spectrum screen. Section 2.2.1
Saved Tuning Allows users to view previously Saved Tunings. Section 2.2.3
Log View* Allows users to save and view log files. Section 2.2.2
o Allows users to change the language for the HD Connect. :
Localization Options are: English, Spanish, and Chinese. Beclin o
Fault Log Allows users to create and view Fault Logs. Section 3.2
Monitor* Allows users to view the status of HD Detectors. Section 4.1
Tune Allows users to make changes to the tuning of the HD Flame Soctth 4.4
Detector.
Allows users to troubleshoot HD Detectors. Good understanding
Tags of Tags is required, so Admin should be careful in allowing user’s Section 4.6
permission for this feature.
8 5 Allows users to view Live Trends, which are useful to learn HD i
Live Trend Section 4.7
current and future trends.
Data logging® Allows users to log data from Monitor page. Section 4.9
Fault Status*® Allows users to view and reset Faults. Section 3.2

*Forney recommends enabling these features for all standard users.
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1 03 WELCOME SCREEN

Once a user logs onto HD Connect it launches a welcome screen as shown in the Figure 4. The left side of
the screen (referred as equipment tree) has the list of COM ports and devices attached to each COM port.
The check-box in the equipment tree can be used to connect/disconnect any COM port or equipment.

The top of the screen has 4 menu items and 5 icons. The menu items are described in Section 2 while the
icons are described in Section 3.

The large window on the right side of the equipment tree displays the icons of currently connected HD
Flame Detectors.

» A green box around the icon represents a fully operational HD Flame Detector with no issues.

* An orange box around the icon represents a fault on the HD Flame Detector.

* A red box around the icon means there is ho communication between the HD Detector and the
computer.

* A flame symbol changes to Red when Flame is detected

A pop-up menu opens upon right-mouse click on any icon. Details of the pop-up menu are described in
Section 4.

Figure 4 Welcome Screen

File View Settings Help
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Logout Fault Log Log View Spectrum Refresh
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HD Connect Manual 9

372001-22 Rev E



The four (4) menu items in the top area of HD Connect are:
* File

* View

* Settings * Help

201 FILE MENU

The File Menu has 6 sub-menu items:

Figure 5 File Menu

ﬂ HD Connect
cile IR

Save view

= Open View

Settings Help

,c' Refresh
(® Logout
'ﬁg Security Configuration
K Exit
V' B FC6666

Table 2 Description of Menu Options

Save View

Saves the current view in a file at desired location on the computer. The HD Flame
Detector icons can be rearranged in any desired manner as explained in Section
2.2.4. The Save view option allows users to arrange icons in different ways and save
their view.

Open View

Allows user to upload previously saved view. Essentially, it rearranges the icons on
screen in user’s preferred way that was previously saved by the same user.

Refresh

If HD units are added/removed in the daisy chain, their status can be updated by
pressing Refresh. This menu option updates the list of current HD Detectors
connected by RS-485; it also updates the status of all the detectors currently
connected via USB port.

Logout

Logs out the current user from the software and returns to the Login Screen

Security
Configuration

Opens a pop-up window, see Section 1.2.

Admin users can create/delete admin or standard users or change permissions
for standard users.

Standard users can view their permissions in this pop-up window.

Exit

Logs out the current user and exits HD Connect application.

HD Connect Manual
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2.2 VIEW MENU

The View Menu has 4 sub-menu items.

Figure 6 View Menu
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2.2.1 Spectrum

The pop-up window for “Spectrum” sub-menu has two drop-downs:

1. Port Address: displays the list of COM ports with active devices.
2. Device Address: shows list of connected HD Flame Detectors for the selected COM port.

Figure 7 Pop-up Window for Spectrum

ﬁ Spectrum

Port Address COM3

Device Address Device 1

o

After selecting desired COM port and Flame Detector, click “Display” to see the IR/UV spectrum.
The Spectrum window is explained in detail in Section 4.5.
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2.2.2 Log View

The pop-up window for “Log View” has two drop-downs on the left side:

* Select Port: lists COM ports with active devices.
* Select Slave: lists connected HD Flame Detectors for the selected COM port.

Figure 8 Pop-up Window for Log View Sub-menu

por I—

From Date 10/27/2023 E From Time @
Select Device = “
To Date 10/27/2023 E To Time o
Tag —_— e
# Port Name Device Name Register No Tag Description Old Value New Value Date-Time 4 Created By

The middle section allows the user to filter specific “From” and “To” dates and time. Clicking the “Show”
button on the right side displays the filtered results. If date and time are left blank, then the results window
will show all results.

As shown in Figure 9, the results page displays the list of registers changed, their old and new values,
change date, and user who changed the value.

Admin users can add privileges for standard users and decide if a user can view the historical changes in
the register values as explained in Table 1. Whenever any parameter for a HD Flame Detector is changed
(using Tune window), the value in corresponding register changes. The changes in the registers are
logged and can be viewed later. This information can be useful for Forney Professionals to troubleshoot
issues with HD Flame detector.

Figure 9 Results of Log View Filter
B R

Port COM10 -
From Date 10/27/2023 From Time (O]
Select Device Device 22 > - “
To Date 10/27/2023 To Time ®
Tag FC1001 T —
# Port Name Device Name Register No Tag Description ©Old Value New Value Date-Time ¥  Created By
1 COM10 FC1001 58 PO - UV Analog Scale Maximum 100 99 10/27/2023 at 13:23.04 admin
2 COM10 FC1001 58 PO - UV Analog Scale Maximum 1000 999 10/27/2023 at 13:23.04 admin
3 COM10 FC1001 53 PO - UV Window 1 Avg Amplitude Drop Off 300 299 10/27/2023 at 13:23.04 admin
4 COM10 FC1001 52 PO - UV Window 1 Avg Amplitude Pick Up 500 493 10/27/2023 at 13:23:.04 admin
5 COM10 FC1001 48-L0 PO - UV Preamp Gain 125 126 10/27/2023 at 13:23:.04 admin
6 COM10 FC1001 49-10 PO - UV AGC Gain 81 82 10/27/2023 at 13:23:04 admin
7 COM10 FC1001 55 PO - UV Window 2 Avg High Cutoff Freq 90 91 10/27/2023 at 13:23:04 admin
8 COM10 FC1001 54 PO - UV Window 2 Avg Low Cutoff Freq 70 69 10/27/2023 at 13:23.04 admin
9 com10 FC1007 51 PO - UV Window 1 Avg High Cutoff Freq 20 19 10/27/2023 at 13:23.04 admin
10 com1o FC1001 50 PO - UV Window 1 Avg Low Cutoff Freq 8 7 10/27/2023 at 13:23.04 admin
1 com1o FC1001 46 PO- IR Analog Scale Maximum 100 101 10/27/2023 at 13:23.00 admin
12 com1o FC1001 47 PO - IR Analog Scale Minimum 500 501 10/27/2023 at 13:23:.00 admin
12 comio FC1007 o PO - IR Window 1 Avg Amplitude Drop Off 300 301 10/27/2023 at 13:23.00 admin
14 com1o FC1001 40 PO - IR Window 1 Avg Amplitude Pick Up 500 501 10/27/2023 at 13:23.00 admin
15 coM10 FC1001 37-HI PO - IR AGC Gain 200 201 10/27/2023 at 13:23.00 admin
HD Connect Manual 7}
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2.2.3 Saved Tuning

The “Saved Tuning” option allows users to upload the same settings on multiple HD Flame Detectors.
The user can load a previously saved tuning, Section 4.4.3 explains how to save a tuning. The software
will redirect and populate the Tune Page to show these retrieved parameters from the encrypted file on
the computer. These settings can then be uploaded to the connected HD Flame Detector by clicking
“Update Detector” button.

NOTICE: Previously saved tunings do not include Device Settings. These settings should be
manually changed, if needed, prior to clicking “Update Detector”. If an application requires use
of more than one profile, each profile must be activated through profile select inputs prior to
updating detector.

2.2.4 Views

The “View” option under the “View” menu has three options. Please note that the Bluetooth® Symbol
shows Bluetooth® status for the HD Flame Detector wherein gray symbol means Bluetooth® is OFF
while blue symbol represents Bluetooth® ON status.

w #’L Standard View lists all the connected flame
IO — detectors sorted by COM port.
v ¥ & - |
L ML This view cannot be customized.

S e " Run-Time View shows the current Flame
: == Status and corresponding Flame Strength
for each detector. The user can arrange
g == these icons as desired and then save
e their view for future use, as explained in

section 2.1

Note: Value displayed for FR1 (or FR2) is
higher of maximum intensity in FW1/FW2
for respective FR.
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2.3 SETTINGS MENU

Settings menu, shown in Figure 10, offers the user three (3) languages:

* English,
» Chinese, and
* Spanish.

Once the desired language is selected, the application logs out to convert the software to the selected
language. The user then needs to log back in to view HD Connect in the desired language.

Figure 10 Settings Menu - Language Selection

E HD Connect

File View m Help
(= English @ |~ i

L
Py -
Logout Fault Log g View Spectrum Refresh
Espariol
Y V &5 PC Ports .
v |/ o5 coM3
v & Fc1a30
v |V o5 comT
v £ FCo566
Tag FC1430
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204 HELP MENU

The Help menu has two (2) resources available for users:

1) About & Instruction manual forwards to Forney website manuals page
2) Terms and Conditions. Opens the respective document.

About shows the version information for HD Connect while clicking either of the other two options opens
the respective document in pdf format.

Figure 11 Help Menu Options

File View Settings

About & Instruction Manual 7~
(= 4 |_M K/

Terms And Condition
Logout Fau Spectrum Refresh

v
Vi PCPorts Tag FC1001 9
v/ *r COM10

v B Tag FC1001 Amplitude Status

FR1 oFF &
FR2 oFF &

Temp 41°C/105.8°F

HD Connect Manual @

372001-22 Rev E



Figure 12 shows the HD Connect icon bar which consists of 5 icons:

* Logout,

* Fault Log,

* Log View,

» Spectrum, and
* Refresh.

Figure 12 HD Connect Icon Bar

HD Connect

File View Settings Help

= A 5 |2

Logout Fault Log Log View Spectrum

v |V 4% PCPorts
v/ e CcOM3
v 8 FC1430

v |V o> com7

v B FC6666

301 LOGOUT ICON

Logs out the current user and redirects to the login page. Admin users can create new user and set their

permissions as needed.
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302 FAULT LOG ICON

A pop-up window opens when the Fault Log icon is pressed. The pop-up window (left picture in Figure 13)
allows user to select ‘From’ and ‘To’ date and time to display the faults occurred within the time-frame.
The fault list results (right picture in Figure 13) shows all the faults occurred in all the HD Flame Detectors
connected within the time-frame selected on the prior window.

Figure 13 Fault List in HD Connect

[ FaunList - o x I8 FaunLin - O X
Date From FE  Timetrom: 0] Date From : 5/1/2018 B rimerrom (O]
Date To: ""- Time To o m Date To: Sj'l ‘,-’2018 '—ﬂ Tume Tor O m
Detector id Port Name Slave Id Fault Code Date / Time Detector Port Name Slave Id Fault Code Date / Time
FRY SENSOR FAULT STATUS coms 1 0 2018-05-01 O4dA2
COM3 1
COMS 1
¥ FR1 SENSOR FAULTSTATUS com3 7
1 SENSOR FAULT STATUS coMs 1
1 SENSOR FAULT STATUS coMs 1
No content in table
RY SEP ULT STATUS COMS 1
FRY SENSOR coms 1 2018-05-01
FR2 SEl 15 com3 1 2018-05-01 072711
FRY SENSOR FAULTSTATUS COMS 1 2018-05-01
FR1 SENSOR FAULT STATUS coms 1 2018-05-01
FRY SENSOR FAULT STATUS coms 1 2018-05-01 072712

303 LOG VIEW ICON

Opens the Log View Pop-up Window. See Section 2.2.2 Log View.

304 SPECTRUM VIEW ICON

Opens the Spectrum screen. See Section 4.5 Spectrum

3.5 REFRESH ICON

When pressed, the Refresh icon refreshes the list and status of HD Flame Detectors in the Equipment
Tree and Icons area (Please see Section 1.3 for the description of the two windows).

HD Connect Manual
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The large area on the right side of the HD Connect screen displays an icon for each HD Flame Detector
currently (or previously) connected via RS-485. The icons can be displayed in three different views as
described in Section 2.2.4.

Right mouse click on any of the HD icons to make a pop-up menu open as shown below. These menu
options are explained in detail in the following sub-sections. Please note that one (1) window can be
opened for each HD Detector. HD Connect does not allow multiple windows for a single HD Detector.

Figure 14 Right-Click Menu Option for HD Icons

HD Connect

File View Settings Help

= A B o 4
L=
Logout Fault Log Log View Spectrum Refresh
— COM4
4]
Tag F
Tune Window
m Spectrum
Tags
Live Trends ' 4] 8
Data Logging
Fault Status
Tag F FW.3-3 Tag FW.1-1 Tag FC1657
About
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401 MONITOR WINDOW

The Monitor Window displays the status of the desired HD Detector. The user can view the status of
the Flame Relay 1 or 2 for the active profile from 0 to 3. The Monitor screen shows the current values of
several parameters and various set-points for the selected flame relay and profile combination.

Figure 15 Monitor Window in HD Connect

Temperature (*C) 41 °C f 105.8 °F Modbus Slave 1D 22 4|
Tag FC1001

0 Flame Relay 1 (IR) Flame Relay 2 (U |

Active Profile 0 r
Sensor Type IR
PreAmp Gain 252
Sensor Signal 58

Gain 201 |
Gain Trim OFF
Weight Factor 1
Low High PPS
Frequency Window 1 9 21 1023
Frequency Window 2 71 91 48
PU 507
DO 301
Analog Scale 230 %
Flame Failure Response Time 1
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4.2 MONITOR OR TUNE WINDOW

Monitor and Tune screens have several common fields. These fields are explained in this section with the
help of data processing flow.

Table 3 Common Fields Defined

Sensor Displays sensor type for respective Flame Relay (FR1/FR2) UV or IR

Displays sensor signal strength on a scale of 0-1023 after processing
though pre- amplifier. Displayed value is influenced by amount of optical
radiation received by the sensor and the preamp gain set by the user.
It is recommended that in no case this signal value should reach 1000.
The sensor signal strength in range 200-600 will help improve flame
discrimination.

Sensor Signal

User adjustable preamp gain (1-255) to achieve sensor signal as

Preamp Gain described above.

User adjustable Gain (1-255). Sensor Signal at the output of pre-
amplifier stage is processed through second amplifier. Output of
amplifier is processed by microprocessor and results of FFT are
presented in Spectrum screen. X scale of the spectrum displays 256
bins at interval of 2 Hz, while signal amplitude at each bin is displayed
on Y axis. Its recommended that in no case signal strength on any
bin should reach 1000. Optimize Gain / Preamp Gain settings to keep
signal amplitude at burner characteristic frequency bin around 600.

B Spectram

-

Gain

A

ORI

IR Spectrum with Frequency Windows 1 and 2 shown in blue
and orange colors respectively, and DO/PU shown in green color

Frequency Window 1, | Highest amplitude between two frequency bins (starting & ending) is

Amplitude 1 displayed as Amplitude 1

Frequency Window 2, | Highest amplitude between two frequency bins (starting & ending) is
Amplitude 2 displayed as Amplitude 2

HD Connect Manual o
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Weight

User adjustable between 1-5. Highest amplitude on each frequency
window is multiplied by the weight setting and displayed as Amplitude 1
and 2. Default value is 1. Increasing preamp gain or gain increases signal
and noise together. It may lead to low signal to noise ratio. However
higher weight setting only acts as a multiplier of Amplitude.

Amplitude PU/DO

Flame Relay status is controlled by comparing highest of two Amplitude
(1&2) values against PU / DO set point. Flame Relay energizes if either
amplitude is greater than PU setting and de-energizes if both amplitude
values are below DO setting

Analog Signal %

Displays analog output signal value in %. Analog signal is scaled as per
the Min & Max settings on tune page.

Gain Trim Control

When on, automatically adjusts Preamp gain to maintain sensor signal
to fixed value of 600. In dark furnace condition, adjusts Preamp gain to
25 to avoid saturation.

Flame Failure
Response Time
(FFRT)

Flame Relay energizes if either amplitude is greater than PU setting and
de-energizes if both amplitude values are below DO setting after expiry
of FFRT setting. Default setting is 1 second; possible values are 2, 3,
and 3.8 seconds.

403 TUNE WINDOW

The Tune Window option allows the user to Tune the selected HD Flame Detector.

When the Tune option is clicked, a pop-up window opens requiring the user to enter a password as shown
below. The Default Factory Password is 1234. Password can be changed under the Device Settings

section.

HD Connect Manual
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Figure 17 Tune Window in HD Connect

Tag FC1001

Active Profile 0 Time Remaining : 09:06 Extend

0 Flame Relay 1 (IR) Flame Relay 2 (UV)

Modbus Slave ID 22
Sensor Type IR
PreAmp Gain 252
Sensor Signal 56
Gain 201
Gain Trim Control OFF D
Weight Factor il

Low High PPS Low High
Frequency Window 1 g 21 1023
Frequency Window 2 71 91 48
PU 501
DO 301

Min Max Min Max
Analog Scale 101 501
Flame Failure Response Time 1 =
Save Locallv

The “Extend Timer” button at the top right corner of the window can be used to extend the duration of
tune mode in HD Connect without the need to provide HD Flame Detector’'s Password (4-digit password).

4.3.1 Flame Relay Settings

Select Flame Relay Settings for FR1 or FR2 by clicking on the desired tab in the Tune Window Figure 17.
The current settings are shown in green on the left, to change the set points for Frequency, Amplitude,
Weight Factor, Pre-Amp Gain, Gain, Analog scale (%) and Gain Trim Control enter new values into the
gray boxes on the right. See Table 3 for definitions of variables.

Click “Update Detector” or “Save Locally” to save your changes. See Save Tuning section for more
details.

HD Connect Manual 9
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4.3.2 Device Settings

Figure 18 Tune Window Device Settings Tab

Tag FC1001

Active Profile 0 Time Remaining : 05:58 Extend

(6]

Flame Relay 1 (IR) Flame Relay 2 (UV)

Modbus Slave ID 22
Sensor Signal FR1 49
Sensor Signal FR2 18
g Bluetooth . on

Update Detector Save Locally

Click on the Device Settings tab to change Modbus Slave ID, Tag Name, FFRT value for each Flame
Relay and Tune Password. Simply type in new values on the right and click to “Update Detector” or “Save
Locally”. See next section for explanation of Save options.

4.3.2.1 Bluetooth® Disable

The Bluetooth® toggle switch can be used to Enable or Disable Bluetooth® for the connected
HD Detector. If the Bluetooth® is currently enabled, click on the toggle switch to disable it.
A pop-up window (Figure 19) would appear to request confirmation. Please make sure to
disconnect mobile device (if connected via Bluetooth) prior to clicking “Apply” on this window.

Figure 19 Bluetooth® Disable Window
Irl Confirm ﬁ1

Connected mobile device should be manually disconnected, then click "Apply”. o

Are you sure you want to Change Bluetooth Status?

Apply Cancel
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After “Apply” is clicked on the window in Figure 19, a new Pop-up window (Figure 20) would
appear to confirm that the Bluetooth® has been disabled. However, the HD Detector must
be power cycled for the change to go into effect. The Bluetooth® chip will continue to remain
enabled & Bluetooth® LED will continue to blink until the device is power cycled.

Figure 20 Bluetooth® Disable Confirmation Window

i -
B | Success @

Bluetooth status changed successfully. Please power-cycle the
device, then Refresh HD-Connect to scan for connected devices.

|

4.3.2.2 Bluetooth® Enable

The Bluetooth® toggle switch can be used to Enable or Disable Bluetooth® for the connected
HD Detector. If the Bluetooth® is currently disabled, click on the toggle switch to enable it.
A pop-up window (Figure 21) would appear to request confirmation.

Figure 21 Bluetooth® Enable Window

1 ®7 Confirm P

Bluetooth changes will be in effect only after device Power-Cycle. 0

Are you sure you want to Change Bluetooth Status?

Apply Cancel

After “Apply” is clicked on the window in Figure 21 a new Pop-up window (Figure 22) would
appear to confirm that the Bluetooth® has been enabled. However, the HD Detector must
be power cycled for the change to go into effect. The Bluetooth® chip will continue to remain
disabled & Bluetooth® LED will continue to stay OFF until the device is power cycled

Figure 22 Bluetooth® Enable Confirmation Window

L .
B Success @

Bluetooth status changed successfully. Please power-cycle the
device, then Refresh HD-Connect to scan for connected devices.
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4.3.3 Save Tuning

Two options exist to save settings in Tune Mode, “Update Detector” or “Save Locally”. The “Update
Detector” sends the desired settings from HD Connect to the HD Flame Detector and saves them on the
Detector. A confirmation is issued from the detector to the HD Connect. HD Connects displays success
or failure in a subsequent pop-up window. Alternatively, the existing settings can be saved at a desired
location on the computer using the “Save Locally” button in Tune window. Please note that the values on
the left column(s) of ONLY FR1 and FR2 are saved while the values under Device Settings section are
NOT saved. Only settings for active profile are saved. Forney recommends user include profile number in
saved file name for easy identification later. If an application requires use of more than one profile, each
profile must be activated through profile select inputs prior to saving settings.

Previously saved tunings can be uploaded from the computer by clicking Saved Tuning in the Menu bar.
This feature allows the user to upload the same settings on multiple HD Flame Detector devices.

4.3.4 Factory Reset

The factory default button on Tune page restores the settings to factory default values. Please note
Factory Reset will reset Modbus Slave ID to 1 and Tune mode password to 1234. Factory reset does not
change user assigned Tag number.

4.3.5 Reset Forgotten Password

To reset a forgotten password, please contact Forney Service Department to request the unit specific
password. Please provide last five digits of the unit serial number and its six-character Tag name when
requesting reset password. Forney will generate a device specific password which can then be used to
enter tune mode and reset the standard password to a desired password. A new device Specific Master
Password may be required if locked out again.

404 SPECTRUM

The Spectrum Analysis (FFT) provides insight into the signal from each sensor (UV or IR). It helps identify
frequency windows and respective amplitude specific to the target flame and used as a guide to change
parameters on the Tune screen (Figure 17). Signal amplitude values are at frequency bin intervals of 2
Hz. For example, amplitude at 60 Hz frequency is displayed at frequency bin 30 on the spectrum screen.
To view the Spectrum Windows simply:

* Click on Spectrum from the pop-up menu.

» Use the check boxes in the top right corner to select IR or UV.

» Use the Intensity and Frequency From and To settings to zoom into sections of the spectrum. Reset
button reverts back to default full scale.
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Figure 23 Spectrum Window for UV sensor
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Figure 24 Spectrum Window for IR sensor
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4.5 TAGS

Click on the Tags to review the information about all available tags and their relevance for the Flame
Detector. The Tags window show the register numbers, their descriptions, and associated values for
various registers of HD Flame Detector. In case of normal communication with HD Flame Detectors,
these values are displayed in different windows of HD Connect. For example, Slave ID (Register #
40000) is displayed on Monitor, Tune, Spectrum windows. In case of communication issues between HD
Flame Detector and HD Connect, the values associated with Tags can be useful to troubleshoot issues
by a Forney Professional.

intensity

Frequency
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Figure 25 “Tag List” Window in HD Connect

& Tag List - O ¥
5r. Mo.  Register Mo, B/16 Bit Tag Description Value
1 40000 Bbit-L My SlavelD 2
2 40000 8bat-H Fault Reset Cmd 0
3 40001 abit-L FR1 sensor type !
4 10001 Bbit-H FR1 Flame relay Stat e
5 40002 abit-L FR1 Sensor Fault Stat o
5 40002 Bbit-H FR1 Contact Descrepancy Stat o
6 40003 16bit FR1 Window 2 Freq o
7 40004 16bit FR1 Window 2 Amplitude Y
8 40005 16bit FR1 Window 1 Frequency 14
E 40006 16bit FR1 Window 1 Amplitude a2
10 40007 16bit FR1 Analog 4-20ma o
11 40008 16bit FR1 Fault Counter 0
13 40009 Bbit-L FR1 FFRT_seiting 1
4 40009 Bhit-H FR2 FFRT setting 1
16 40010 Bbit-L FR2 cantor typa 1
17 40010 8bit-H FR2 Flame relay Stat b 0
18 40011 Bbit-L FR2 Sensor Fault Stat 2
12 40011 gbit-H FRZ Contact Discrepancy 0
20 40012 16bit FRZ Window 2 Freq o
21 AR Akt [ o T (= I NP LT e P 22

406 LIVE TRENDS

Live data for Flame Relay 1, Flame Relay 2, and Internal Temperature can be viewed for any connected
HD Flame Detector. Hover the mouse over the Live Trends option to view its sub-menu. When any of the
options (FR1, FR2, or Internal Temperature) is clicked, the Live Trend window opens and starts plotting
the live data from the Flame Detector (right-top screen in Figure 26).

Save Live Trends: To save a trend, click “Save Trend” button and save file to a desired location on the
computer (right-bottom screen in Figure 26).

View Previously Recorded Trends: Click on the “Recorded Trends” tab and select “Load Trend” button to
locate and open a previously saved Live Trend (left-bottom screenshot in Figure 26).
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Figure 26 Live Trends and Options
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07 DATA LOGGING

Data logging can be initiated by setting COM port, Modbus Slave ID and From/To time for any specific HD
Flame Detector. Any or all registers can be chosen to record current or future data. The data will then
be stored at the user specified location and can then be imported into Excel® for further analysis. The
Configure Data Logging tab shows the various options to start data logging. The Log History tab shows
previously saved data files.

NOTICE: Data logging is not password protected; so data saved by one user can be viewed by
another user provided they exchange data files.
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Figure 27 Configure Data Logging Tab of Data Logging Screen
Mosagsro X

Configure Data Logging  Log History
Port : COM10 Slave : 22 Tag : FC1001
From Date 10/27/2023 ki From Time 316 PM (O] Logging interval (second)
S s
Ta Date 10/27/2023 ToTime 316 PM @
Sr. No - Reg. No Description |

1 40004 FR1 Window 2 Amplitude |
2 40006 FR1 Window 1 Amplitude |
3 40007 FR1 Analog 4-20mA |
4 40013 FR2 Window 2 Amplitude i
5 40015 FR2 Window 1 Amplitude i
6 40016 FR2 Analog 4-20mA |
0 40018 Error Bit Code - MSW |
8 40019 Error Bit Code - LSW
9 40022 internal temperature
10 40023 CPU temperature
n 40025 Max Internal Temp Recorded
12 40132 IR Preamp output
13 40133 UV Preamp Output

R R R A e A i i A ' i R R R i e e R R BB |

Figure 28 Log History Tab of Data Logging Screen
@oemegong X

Configure Data Logging  Log History

Log Name Log Start Time » Log End Time Status
datalog1.xlsx 10/27/2023 15:09 10/27/2023 15:15 Completed

testl.xlsx 10/25/2023 10:27 10/25/2023 10:36 Completed
datalog_1.xlsx 10/12/202311:13 10/12/2023 11:16 Completed
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4. 8 FAULT STATUS

Clicking on Fault Status opens the Fault Status window as shown in Figure 29. If the red fault LED on the
HD Detector is lit, click on the Fault Status window to determine the cause for the fault. The fault type and
fault counters for each sensor are shown here. Power cycling the detector resets the fault alarm on the
detector (red LED is no longer lit), however it does not clear alarms displayed on this screen.

If any HD is in fault state with red LED on the front display lit, user should:

1. Reset fault by cycling power to the HD Detector, this will clear the detector out of fault state (red LED
on front display will turn off),

2. Then use the Fault Status page in HD Connect to determine the reason for the fault.

3. Use ‘Clear Alarms’ button to clear alarm displayed on this screen. Alarm counters will continue to
display current value.

& NOTICE: The Alarms must be cleared after a fault occurs to accurately determine fault next time.

Figure 29 Fault Status Window
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Table 4 Fault Codes

Value Error Description

0 No Error

1 Unknown HW (Hardware) Fault
2 Unknown SW (Software) Fault

3 HW Fault - EEPROM

4 SW Fault - Factory Values Reset

10 Temp Fault

1 Temp Alarm

2 Temp Above

20 Modbus Error

24 lllegal Slave ID

30 Bluetooth Error

28 lllegal Data Value / Value Not Accepted Outside of Tune Mode

85 Bluetooth pairing failed

36 Bluetooth Connection Error

657/ Bluetooth Authentication Error

40 FR1 Sensor Fault

50 FR2 Sensor Fault

60 Watchdog Fault

70 FR1-New Discrepancy Fault

80 FR2-New Discrepancy Fault
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501 CONTACT INFORMATION

For assistance, contact Forney’s Aftermarket Department via any one of the following methods.

spares@forneycorp.com

972-458-6100 or

972-458-6142 or
1-800-356-7740
(24-hour direct line)

972-458-6600

5.2 COMMON ACRONYMS

FFT Fast Fourier Transform
FR Flame Relay

HW Hardware

IR Infrared signals

SW Software

uv Ultraviolet Signals
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